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11 Overview
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Chapter

Before working with ComiMuink3

g TR0/ 0] BAIROK= 240 B KO} BN 0K BFRIGILICH OHFE2
BLERJ0fe} C1£0] T 7/59| AZEG 0= DABAIN S 240 S8 T2 1Y 752 S1
QISLICH O3] f O/ TLIHA] DRI ComMUiniG = L} 73k 278+ /52 HFOR

G2} S0 AL 2 [&= 2L =11 2L} PIL)ef0f = B ZI gL/

ol A= MECHATROLINK-IIT o] tfgh A 2je} A3 @AW 2ol ComiMLink3 of o gt

AUE fIg gz A Fyth Bt 4l&e Ve 97 wE goluye 7)F

| B F5EMMS e FAAGER)HE RS, A BALEEE Sk o]F rF Tho| =744
& gL ol (REfiF) A = A EF HAE thelglF U

13



CHAPTER 2 :: BEFORE WORKING WITH COMIMLINK3

2 MECHATROLINK-III & ComiMLink3
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Development Environment for
ComiMlink3
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3.2 ComiMLink3 &
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3.2.1 HARDWARE Layer
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orlan . 1sua.
- MS VC++ Ctt Builder Borland Delphi Basic Shatp)
Bl
ComiMLink3 | ComiMLink3
ComiMLink3 21 & 3| o] ~ _SDK.h _SDK.h
v g ComiMLink3 | ComiMLink3 | ComiMLink3 | ComiMLink3 | ComiMLink3
_SDK.cpp _SDK.cpp PAS BAS CS

ComiMLink3 ComiMLink3 | ComiMLink3
AR ) A 0] 91 _SDK_Defh | _SDK_Defh

¥ 5 ComiMLink3 Q1E] #| o] 2 G4 9} ok

Microsoft it 2] Y= FG A AN A & 2F8}= DLL(Dynamic Link Library) 8 E] 2] ComiMLink3 &= “37]
ol A e A A, 2hel B 2] I #lo] 25 $13) “ComiMLink3 S1E 9| o] 2 2} 3} 2o] H g 2] 9]
HEShEL B AR, 7} HlolE 752 913 “ComiMLink3 < (Hi 8 78 o] 3L & Al&stal sy k.

G301 =0t A EE) DA “ComiMLink3 QIEJFo] 2 3}d» & F3] ComiMLink3 o] 3%
YA Hog ez gale LIAZA 4 Q qu olo| we} A7) T3 AN AL YA eg
Aiyth wkep olele] Sl A3 ComiMLink3 & AHE-SHA7] shalvid, A3 &34 012=0t
A A HO = A= A7) vy .

3.3 O E&F g ot
A13] @HOIZOtel M= A E) D 5] el g arlS doj=e]7] flate], W82 A« 3
Al C++ F-H Borland International MA Object Pascal ©] Delphi A&+, 712] 31 A NET :?1'73 A e %
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golH g QA Ho|AE AFst AFUTE 53] o]/ ComiMLink3 ol A= 7l g7 2] A sz rid<l ¢
Sharp(C#) 1015 ¥4 A HskaL 3le ﬁ Hop A28 73 Ao A A 8] @AOIEROF A% = A5 4=
NEE TS 78k 5 Y Th

a3t QA H o] ~(nterface) IU-> AA kAol F 37O A Header HUEE TZAE a2
HEEAl ARGo] HUth A2 @AHOIZOF ComiMLink3 ©ll4 A8k IE o] ~vtde] Fr= vha3)
EEU

rE
m

|

Visual C++ / Borland C++ Builder

Az m C:\Program Files\COMIZOA\AUTOMATION3\NEMO\ Libraries\x86\
e c Motion(DLL)\MECHATROLINK3_I.X530\VC++

< 3 ComiMLink3_SDK.cpp, ComiMLink3_SDK.h, ComiMLink3_SDK_Defh
Delphi

Az m C:\Program Files\COMIZOA\AUTOMATION3\NEMO\ Libraties\x86\
o= Motion(DLL)\MECHATROLINK3_LX530\Del

94 ComiMLink3.PAS

Visual Basic

C:\Program Files\COMIZOA\AUTOMATION3\NEMO\ Libraries\x86\
Motion(DLL)\MECHATROLINK3_L.X530\VB

d ComiMLink3.BAS

CRA:

a

C# (CSharp)

C:\Program Files\COMIZOA\AUTOMATION3\NEMO\ Libraties\x86\

A2 .
Motion(DLL)\MECHATROLINK3_I.X530\CSharp
g ComiMLink3.cs

k
(@)}

o] A& @AM Fololl A A F-3F= COMI-AUTOMATION A %] 2 & 12l o]
7|8 A 7cy Egtol Bl AX¥ AL 7|Fo 7 sht),

Qg | o] 2 gp o gzl A zpA 8] A el T4 A 8.
HA, A 3] @AM 20}01] ] Al &3 ComiMLink3 ¥ DLL & ] ]
glol B & g] Q1 E H o] ~E A F3l= UP°]iEiEE$J]°19] Ae o
T SolB S ““LHE} O A& GALS] A F2] 7 5s FEE
M S 8 g 41135:}?/&011/]1—4_

IAEFR)DEAAM = ol &, F 7] TS FalA A3
gF ) o)) AE FS o] &sHA A HU T
J# g vlo]l a2 A E 9 DLL ol B el F24 Al Esh=
Frss wﬂMWPT‘ﬂAWEEXw%MV”*ﬂ%HWE+1
T =g A g v i o] Jlgu v A SR e S 4o
AP S 4 7 sy

[.

ComiMLink3 o] thal| A 71 AR89 & 7} 78k 7 of] 27
Algsl =2 7] 98l [RIE H o] &) qu%‘% Al

N3 (VC++, Delphi 5) el A 71 3k~
oY BEEA M= WEA] o] [QIE H o]~
ComiMLink3 S AF-&3F 4= ‘EASHD}.

>m

1
| 51 & ALgSHA o,
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3.3.1 Visual C++ 6.x 7[|'}#}= 913} ¢F

Microsoft Visual C++ 6.x | 4] ComiMLink3 =

COMIZOA MECHATROLINK-IIIl SOFTWARE DEVELOPMENT KIT

g

AHgSHAT 1T Thg-o] A Afol whek A shAl | B .

C

Project Start

)

I

ComiMLink3

<4

LibraryS S

YES

ComiMLink3.DLLI}& 0]
StEXEIN20| U= EG
Bl =ZE S, 22

X
L

ComiMLink_SDK_Def.h
ComiMLink_SDK.h
ComiMLink_SDK.cpp

3l 2 ProjectZol| = A}

= 220l A XIoHOF &LICH

[ XIJt DLLS

A 4

ComiMLink_SDK_Def.h
ComiMLink_SDK.h
ComiMLink_SDK.cpp
User Projectoll ! =7}

[Project] — [Add to Project] —

ot Mey

4

ComiMLink_SDK.h
ComiMLink_SDK_Def.h
sici mhe Ft

#include “ComiMLink_SDK.h"#+&
=7t

#include “ComiMLink_SDK_Def.h”

4

2 F7t

ComiMLink.dll 2 2EEst= &= OninitDialog() ® &{ ==of|
F7t cmclLoadDIl() &4 F7}
i
ComiMLink.dlIiE & =6t= &= DestoryWindow() &t & ==0fl
= cmcUnloadDII() & 4 =}
i
DLL & X oAl et =Jt
Y 2=

3-2 Visual Studio 6.x 1 4] 2] ComiMLink3 A}-& <=4 &=
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Visual C++ 6.x =

& AAFYT. w70l A File > New & AEaio] A2 g =2 s

Yol Microsoft Yisual C++

J File Edit Miew Insert Project Build Tools Window Help

Open Cirl+0

J e, ,, Ctri=h | Bk |'3it|5

“ Close

Cpen Workspace

Save Workspace "I
Close Workspace "I

| Ctrl+5
Sawe As,,,
& Save Al

19 3.3 Visual C++ 6x o] M2 T2 AE QA 31

|

37

o

A A,

MFC AppWizard(exe) S A B &ta, T2 AE S YA st 91X 9} T2 AE o] 55 423 5 [OKHES

29 U

New

Files Projects |‘“ ksp | Other D |

L& ATL COM App¥izard
¥|Cluster Resource Type Wizard

#fi=MFC ActiveX ControlWizard
8] MFC AppWizard [(dll)
EAMFC AppWizard [exe]
\New Database Wizard

71 Utility Project

a|Win32 Application

Win32 Console Application
%] Win32 Dynamic-Link Library
=] Win32 Static Library

3

Project name:
ITesd

Location:
IC:NDOCUMENTS AND SETTINGS J

@ Create new workspace
" Add to current workspace
I~ Dependency of:

| El

Platforms:
[#'Win32

0K I Cancel

I 34 AR 2 AE A 3

22
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MFC AppWizard 7 ©] YEFHH [Dialog based] & 41 B 3} 3L [Finish|H &5 S g4t}

MFC AppWizard - Step 1

Application

What type of application would you like to create?

ngle document

8i
" Multiple documents
o

=

What language would you like your resources in?

|5t =0{ (APPWZKOR.DLL) -

< Back | Next > | Finish | Cancel

1% 3-5 MFC AppWizard ©] Application Type 41 8 3}

VC++ & Q18 ¥ 0] 2 A 9] 512 2] ComiMLink3_SDK.h, ComiMLink3_SDK.cpp, ComiMLink3_SDK_Defh
HAS AR YA T2 AE ZH 2 B gy,

W] 570l A [Project]->[Add To Project]->[Files] & A1 & g t},
*.test - Microsoft Visual C++ - [test.rc - IDD_TEST_DIALOG (Dialog)]

Eile Edit Miew Insert Project Build Tools MWindow Help

|
2 = i Set Active Project ' |PSAsmPacket6D = [[
| J|_ &dd To Project b New, .

Wurkspa-::t: test': 1 Dependencies...

=3

Source Contral 3

- test files Settings... Alt+F7 B
S Fil Export Makefile, ., ...
Q Lért[n:jif; [E::psp @ Components and Contrals... |

Insert Project into Workspace, ,,
test.cpp - : : |

| test.rc | ‘ - ||

23
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WorkSpace 42| FileView § ol A [AAd g 2 A E o] & ]+Dlg.cpp I =

19 3-8 AFEA7F MPC AppWizard & &34 A4 ¢ A= = 0] ComiMLink3 3+ & 7}

Insert Files into Project

a3

|h] testh
adltest rc

= QR0 [Sitest - 8 exE-
C3Debug 5 Stdafs, cpp _E] testDlg. h

Cyres |n] StdAf,h

=] ComnildLin e test.cpp

63 testDlg,

CPp

["ComiMLink3_50K, cpp™ " ComikLink3_5DK. h

|C++ Files (.c:.cpp:,cxws, iz hatlh inls,re)

=l

Insert into: |tc51

=l

a9 37 22 AE F71E

SRR

Fiy

3}

A

il

e g o,

Workspace "test': 1 project[s]
= test files
-3 Source Files
ComiHLink3 SDK.cpp
StdAfx.cpp
¥ test.cpp
testrc
-3 Header Files
ComiMLink3 SDK.h
ComiHLink3 SDK_Def.h
Resource.h
StdAb<.h
test.h

// testDlg.cpp : implementation file

Iz

t#tinclude "stdafx.h"
#include "test.h"
#tinclude "testDlg.h™

"ComiHLink3_SDK.h"
"ComiHLink3_ SDK_Def.h"

#ifdef _DEBUG

fidefine new DEBUG_HEW

H#Hundef THIS_FILE

static char THIS FILE[] = _ FILE__
#endif

3}
=

©] F]+Dlg.cpp) T+ 9] OnlnitDialog() &~ WH-2] “TODO” o} ol “cmcLoadDII();”S

--E4 test classes
+-®1% CAboutDIg
+ -8 CTestApp
- ™% CTestDlg
§ CTestDIg[C¥nd *pPare
%% DoDataExchange[CDat
To[OnInitDialog(|
?% OnPaint()
% OnQueryDraglcon(]
% OnSysCommand{UINT
& m hlran

Sh=

I¥39DIL 2E g4

/4 Set the icon for this dialog.
// when the application's main !
SetIcon{m_hlcon, TRUE};
SetIcon{m hlcon, FALSE});

/4 TODD: add extra initializatio
cmcloadDl1();
return TRUE;

fFf return TRUE un:

H

T=3hd

24
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AFEA} 2HA Z 2 g3 o] £ 1 ¥ DLL 2 Unload A 7 ¢F &Yt} DLL 9] Unload = AF&AF 24

Z 20 TR A o] Fo] A oF 31 emcUnloadDIl() 0] 2k & F 3l A] o] Fof Ju T}

cmcUnloadDIl) = F+7} 8= WH & th &7 254t

Class View ;‘g—oﬂ /\-] (}\(}J] ] ‘3]— ﬁiXﬂ E O] E)‘FDlg] FYAE U]’—?*.}_\_ 3%% H']’E‘.g-i %Q
570l 4] [Add Virtual Function]= 1 8 &4 T}

ot

Sl

d

(3]
H

T LWAnuuny
%= CTestApp ‘ FF Set the
= - ff when t
& CTestl  Go to Definition [:—
% DoDat.  Go To Dialog Editor -
% Onlnitl  Add Member Function, ., f
P OnPail  pdd Member Variable, ., 11

%9 OnQue Add Virual Function,,

1
g‘ D"?_I:'I"rs Add Windows Message Handler,.,
| L?BmFUI:I:: B Feferences,.,
. .'[:TME?EhI'IiE o Derived Classes, . -
|
+ (1] Globals ' Dase Classes.. &

New Virtual Functions’ &9l A] ‘DestroyWindow'& 41 B 3 Th5 [Add and Edit| ] &5 8 3t}

New Yirtual Functions Existing wvirtual function overrides 0K
i DoDataExchange

CalcWindowRect ”~

Create T Cancel

DefWindowProc
Dokodal ~ -
GetScrollBarCtrl
OnAmbientProperty

OnChildNotify Edit Existing
OnCmdMsg

OnCommand
OnFinalRelease
OnNotify
OnSetFont
PostNcDestroy =
PreCreateWindow
PreSubclassWindow
PreTranslateMessage b

DoDataExchange[]: Called to exchange and validate dialog data

1% 3-11 DestroyWindow &~ 7}
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(g T2 A E o] F)+Dlg = =9 MHEG 2 DestroyWindow ()l ‘emcUnloadDI(); = F7}F 4 o}
‘emcUnloadDIl(’$H 5 F7} 31 =97t T8 2 v A5 2.2 DLL = 8| Al F1o}
L omm CTt:stD-I!-] return {(HGURSUR) m hicon;
|
& CTestDIg[CWnd *pPare ;
¢| DestroyWindow() BOOL CTestDlg::DestroyWindow()
%$ DoDataExchange[CDat £
%§ OnlnitDialog() Zf TODO: Add your specialized cod
%o OnPaint()
% OnQueryDraglcon() return CDialog::DestroyWindow();
% OnSysCommand([UINT H
[ (]

Y3 P2DILEEEAZE I= F7}
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3.3.2 Visual C++ 8.x 7| A= 93k ok
Microsoft jit:2] Visual C++ 8.x (Visual Studio 2005)°1 4] ComiMLink3 & AF&-&FA 8 th-5-2] Ao u}ja}
ARESAI A U T

< Project Start >

|
ComiMLink3.DLLIIZ 0]
1.DLLS &8t EXELNIZ0 A= ZdH

VES 2.AER AAE EH S, 2 MOt
\ DLLE ¥ = == = R0l ?IXIcHOF &fLICH
ComiMLink3 SDK_Def.h
ComiMLink3_SDK.h
ComiMLink3_SDK.cpp
3 S ProjectZH Ul S A
v
ComiMLIink3_SDK_Def.h
ComiMLink3_SDK.h [Project] — [Add to Project] -
ComiMLink3_SDK.cpp I MEH
User Project0il I+ It
i #include “ComiMLink3_SDK.h" 7 &
ComiMLinkS_SDK.h =9}
ComiMLink3_SDK_Def.h #include “ComiMLink3_SDK_Def.h”
Sl ot =Ot 2 =)}
Y
ComiMLink3.dll 8 2E5H= 84 OninitDialog() &t & =0
=7} cmcLoadDII() & 4= =t
ComiMLink3.dlIS A2 =5t= DestoryWindow() 2t & == 0f
st A =7} cmcUnloadDII() & == It

1% 313 Visual Studio 8.x °| A 9] ComiMLink3 AF-& <=4 &=
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Microsoft jit: 2] Visual Studio 2005(°] 3} VS2005)E 4 & 31T}

A

7ol A [File]->[New]->[Project] & A B 8}o] A2 L2 AE S A

Start Page — Microsoft ¥isual Studio

W Edit Miew Tools MWindow Community Help
[ New » [ Project,., Ctrl+Shiftshl .
Open b '@ Web Site,,,
LClose 1 Eile.. Ctrl+h
Project From Existing Code..,
= Micrgscﬂ'
« Visual Stud
@l Save All Ctrl+3hift+3
Recent Projects
O3 2 2 AE A A2

[New Pro]ect] o] b o] YEFUH, [Project types] ol A = [Visual C++]S A B 8} 4L, [Temeplates] ol A1 [MFC
Application] & A Bl gt 12]al 2R AES PP §) x| o} ZRAE o] 55 AHT F [OKM ==

=
=2 § ).
New Project [F I

Broject types: Templatss: |
& Visual Basic Visual Studio installed templates ~
indows — ]
Smart Device o Custamn Wizard (F3Windows Farms Application
Database FICLR Console Application TAWin32 Console Application
o tarter K EATL Projsct 1 MFC Agplication
Visual J# (E]Makefile Project 1 ABP.MET Web Service
Wisual C++ @ATL Server Project ﬁATL Server YWeb Service
Other Project Types THATL Smart Device Praject {FAClass Library
CACLR Empty Praject 7 Empty Project
g MFC Activex Control MEMPC DLL | |
EEMFC Smart Davice Activex Contral ;aMFC Smart Device Application
s MFC Smart Device DLL (350L Server Project
[= Win3Z Project EWinSZ Smart Device Project
7 Windows Forms Control Library AWindows Service ]
A project for creating an application that uses the Microsoft Foundation Class Library
Name: [LoadComiDIl ]
Location: |C#Documents and Setings#INWHEE! SIS Work v| [(Browse. ]

Solution Mame:  [LoadCamiDIl

| [Create dirsctory for solution

I 3154 Z2AE

Overvisw
Application Type
Compound Document Support
Document Template Strings
Database Support
User InterFace Features
Advanced Features

Generated Classes

Welcome to the MFC Application Wizard

These are the current project settings:
* Multiple document interface
+ Mo database support
* Mo compound document suppork

Click Finish From any window to accspt the current settings.

After you create the project, see the project's readme k=t file for information
abaut the project Features and files that are generated.

i Finish Cancel

19 3-16 MFC Application Wizard ©] Overview S+
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[Application Type] ol A [Dialog based]% Melsl o , [Use Unicode lerarles 3l A (Uncheck) 3} o}-&
[Finish] & 2 2 3h4 T},

MFC Application Wizard — LoadComiDIl

T —
e Application Type
[l
Qwerview Application type: Project style:
application Type (O Single document
() Multiple documents (#) MFC standard
® Dialog based Use of MFC:
[ Use HTML dialog (%) Use MFC in a shared DLL
User Interface Features () Multiple top-level documents () Use MFC in a static library

Advanced Features

Generated Classes
Resource language:

EED v

[ use Unicode libraries

[ < Previous ][ Next = ][ Finish ] [ Cancel

1% 3-17 MFC Application Wizard €] Application Type 3}

ComiMLink3_SDK.h, ComiMLink3_SDK.cpp, ComiMLink3_SDK_Def.h

VC++ & QIE# o] = o] 34Ul C
ZEAE ZE R FAFFYLL

shel & AR A4 E

] 570l A [Project]->[Add Existing Itemc] < A1 8] g T},

22 LoadComiDIl - Microsoft Visual Studio
File Edit “iew | Project | Build Debug Tools  Window

| ] sl o | Add Class,,,
> i Add Mewitem..  CilsShifted b,

i - - 2 Jj.||i_i-] &dd Ewisting tem,., Shift+alt+a, N

Exclude From Project

Solution Explaorer -
& 2 Show All Files
'_; Solution "LoadC Set as Startllp Project

- 24 LoadComil
= [ Header F

Properties

217 3-18 M 470l 4] Add Existing Iteme A1 ) 311
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C ef,

¢4 LoadComiDLL, cpp
| [n] LoadComiDLL, b

My Projects | i@l LoadComiDLL,rc

¢ LoadComiDLLDIg, cpp
31 [n] LoadComiDLLDIg, h
o |n] Resource.h

My Cornputer A stdafx, cpp

|n] stdafx, b

File narme: | v| [ = ]
Files of type: |\.fisual C++ Files (=0 = cpp) = cxnt = cch w400 =Hh =h: .v| [ﬂ]
39 AR F718 HUE A g

WorkSpace 2] FileView 5l A ([A3/d & =2 A E ©] F]+Dlg.cpp) F L= A&t}
shel o] g 9 %ol QlEl sl o] 2= 3kl & FAFF o,
[P SDMﬁnn'LnaannﬂDLL'{1prﬂs|(GMha|5cnpe)
= 24 LoadComiDLL . — .
& [ Header Files Eii LoadComiOLLOlg.cpp ¢ implementati
[d Resource Files
= | Source Files ginclude “stdafx.h”
& ComiMLink3_SDK.cpp #include "LoadComiOLL.h"
¢ LoadComiDLL, cpp #include "LoadComiDLLOlIg.h”
¢ LoadComibLLDlg, cpp
¢ stdafs cpp
[Z] Readhe.txt

finclude "C

s Rifdef _ODEBUG
L#define new DEBUG_MEW
fendif

19 320 AHE-AF A CPP e ofl FT] F7F S

(A4t L2 A E o] F)+Dlg.cpp I+ 2] OnlnitDialog() 35~ WH-2] “TODO” o} ol] “cmcLoadDIl();”" &

7} gk
& CLoadComiDIIDIg(CWnd spParen]| T 7T EEEEN
3% DoDataExchange(CDataExchangs Setlcon{m_hlcon, ~
3% GetMessageMap(void) const Setlcon{m_hlcon, |
;% GetThisMessageMap(void) . .
;% OnlnitDialog{void) /7 T0D0: 012100 2

3% OnPaint{void)

3% OnCQueryDraglcon(void)
3% OnSysCommand{UINT nlD, LPAR return TRUE: //
3@ m_hlcon }

1% 3-21 LoadDIl F7}

AFEAF 24 2 ;o] £ 8 W DLL 2 Unload A A ¢F &Yt} DLL 9] Unload = A&} 2FA]
g3 o) F 7 A] o] Fo] A oF 1 emcUnloadDI() 0] 2H= 32 F8j|A] o] Fof F Ut}
cmcUnloadDIl() S 57} 3F= W & o532 25U
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Class View F ol Al (B3t 22 A E o] F]+Dlg) ==& A8}

Cyg &=
<Searchs 3|

=24 LoadComiDII
- = Maps

‘i Global Functions and Yariables

0 Global Typedefs

= Macros and Constants

“e CaboutDlg

“e CLoadComiDllapp
ClLogdComiDlDlg

=2 _TCmarcDir

=7 _TCmbéxis

219 3-22 AH-8-A} 234 Dialog Class A1 €

A

(A g L2 A E o] F)+Dlg %ﬂ] 7\7]- e e ol A Properties 2] ‘Overrides& A1 B 4 o},

2 7 el |

=] Cummun

accDoDefaultéctic
1% 323 Overrides A1 &

‘Destroy\X/inodW’?Q’% Ao Fw HtAE F8 5] ‘<Add>DestroyWindow’*§: A Elgy o}, (*ﬁ A3k
I ZAE o ﬁ)*‘Dlg ey ‘DestroyWindow’ﬂ'}E o] &9] e¥Elol=H sk} 71 Hu o

Froperties - 1 X
CLoadComiDIIDlg YCCodeClass -

=3l @ # m[e]

Createlndirect
CefWwindowProc

Destr ay Wind o w

DoDataE[ZEJd> Dectroy mindo
Dotoda

|3

Durnp
—_——t - - aLd

19 324 Destroy Window $ = 7}

([7‘3 A3 T2 AE o] =]+Dlg) = /\-/] W gk=el Destroy\)(/indow()oﬂ ‘cmcUnloadDII(); = < F7 gy
‘emcUnloadDIl(’$5 71 8lH =97t T8 2 u] A5 22 DLL = 3|4l g4t}
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i CLoadComiDNDIg{CWnd spParen; L

i» DestroyWindow{void) 2 BOOL CLoadComiDIID0g: :Dest rovWindow( )
3% DoDataExchange{CDataExchangs i
;% GetMessageMap(void) const /4 TODD: Add wour specialized code

3% GetThisMessageMap{void)

% OnlnitDialog{void)

3% OnPaint{void)

3% OnQueryDraglcon{void) }
3% OnsysCommand{UINT nlD, LPAF L

19 3.25 UnloadDIl 5= 37}

cacUnloadDl I );

return CDialog: : Dest rovWindow! )
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3.3.3 C++ Builder 7' %25 $13F oh
Botland/CodeGear C++ Builder © 31 7§ 3173 ¥ €1 C++ Builder 5, C++ Builder 6 & Borland Developer
Studio 2006, 2007, RAD Studio 2009 B A A4 ComiMLink3 ¢] ¢lE]#Ho]~ A2 wWwlo] wl-$- FALE17]
FEREE PSR P TE ey

2= Zﬂ(Version)g C++ Builder 9|4 ComiMLink3 & A}8-3FA 8 TF3-2] A& E3) et vEo A7)

ahgh e
( Project Start )

ComiMLink3.DLLII 0|
1.DLLS S8 EXELIZ0| Y= ZH

2R ANAE 20 S, 2E M HMILDLLS
RS 5= A= 20l ?IXIcHOF &LICH
ComiMLink3_SDK_Def.h
ComiMLink3_SDK.h
ComiMLink3_SDK.cpp
30t = Project=ZH 0l S At
ComiMLink3_SDK_Def.h
ComiMLink3_SDK.h [Project] — [Add to Project] —
ComiMLink3_SDK.cpp ot e

User ProjectOil I+ 30t

.

ComiMLink3_SDK.h #include “ComiMLink3_SDK.h"#1 &
ComiMLink3_SDK_Def.h

=t
3o oFe =0 #include “ComiMLink3_SDK_Def.h”

= —
o2 =t

.

ComiMLink3.dil £ 2 3H= &4 OninitDialog() B b1 & =~ O
=9} cmcLoadDII() & == It
4

ComiMLink3.dIIS ¢ 2E6t= &= DestoryWindow() 2t &t <=0l
> cmeUnloadDII() &4 220}

H
)

1% 3-26 C++ Builder o1 4 ComiMLink3 AF& 54 &=
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W AEALE 91 A hol A= e

3 0] C++ Builder 0] 3H S F3) b sl =] ==
A E Y.
C++ Builder & A 3t} w570l A [File]->[New]->[Application] & A B3} Aj 2 Z 2 A E
Al Ay ot

¢ C++Builder 5 - Projectl

“ D I IQ Standard lAddi‘i"“a'l Win32 | Svstem| DataAcces:
I =l OF 8 AmE®r

1% 327BCB5 oA A 2 2 AE B4

¥ New ltems

E x|
Projects I Data Modules I Business |
New Active I Multer | Project2 | Foms | Dislogs |
[ @ -
Batch File CFile Component Console
Wizard

719 328 BCB5 oA A2 Z2AE A

(5 C++Builder 6 - Projectl
I File Edit Search Miew Project Bun Component Database Tools Window Help

T 3 Application Ll| Win32 | Sustem| DataAcces
- & Open,,, CLX Application

wl | bl Ok
;.I:E Open Project,., Ctrl+F11 Data Module E‘L) Ak oo

1% 329 BCB 6 ol A A2 2 A E A4

5 Borland Developer Swdio2i0s
T;"ﬂq Edit Search Wiew Refactor Project Run Component Tools StarTeam
| New » ] {5 Unit - C++Builder
{_'Q Qpen.,, @@ Package - C++Builder
¢ Open Project... Ctrl+F11 L@_ VCL Forms &pplication - C++Builder
Reopen » |7 Eorm - C++Builder
1% 3-30 BDS 2006 o A A &= R AE A

— 1

C++ Builder 2! VC++ & &

QlEf s o] 2 A 2] 32U 3] ComiMLink3_SDK.h, ComiMLink3_SDK.cpp,
ComiMLink3_SDK_Defh 3}

Q
o
Qe ATtz A H TR E Er BA g,

1= 3N ER
e omikLink3_ 50K, cpp 2eKB  C++ Source
|h] CormikALink3_50k. b BEKE C/C++ Header
|n] ComitLink3_SOK_Def,h 2B C/C++ Header

19 3.31 ComiMLink3 AF8-A] &0 2 AR5 = 5}el
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LA

Borland jil: 9] C++ Builder 9l 41 3= [File]-[Save] or [Save Allj < 8] F0]of L2 A E £ Yl
ZRAE AP GIdES YT

2 3 2] C++ Builder o A F718 Q1B Fl o] 2 9} & A A AHE A T2 A E o] F7F4 Ut Project 9]

| 72] Add to Project = AMgskAH H Yt

T‘Q’;%.C++Bui|der 5 - Projectl

“ D E“h - u | ﬁ E l .i"'.ljlj to Project, ., Shift+F11

ina2 | Svstem| Data Acce

(= Remove from Project,,,
5 » v ab] ok) [x
”@ F 0 ‘ Dl“ < " ) Import Type Library, ., A [0 rrg
STENTEREEr— P Add t Ropostory... —
[Fom1: TFom1 - ‘L’""’WS"“’“ e
7 anguages | 70 S S S S R
PropetiesEranial |l Ermnmmmese o Sttt
i =l ¥ Edit Option Source s
Action Export Makefile, ., s
Artivelantenl B G R R
1% 3-32 C++ Builder o] 4] Z2 A Eof] 5} =7} vhA 1
add o project 21
=X [S common r] e®@eE

ComiMLink3_SDK_Def.h

I} DIE(N): | | £71(0)

I = A(T): |&ny file (=) | HX |
7

1% 3-33 C++ Builder o] A Z2 A E o 3} =7}

| Project].exe ﬂ

Filez

= I@ ProjectGroupl
- @ Project].exe
El Projectl.res
@ F'rljiEE:H_l::pl:l
+ El Initl.cpp
=] ComitLink3_30DK, cpp
k2] ComitLink3_SDK.h
EI ComikLink3_S0k._Def b

1% 3-34 Project Manager 9| A =7} 2+ EF21 (fi i)
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eholmele] §4 5 AHESaA sHe T A S8 EE 1 shelo] AR H o] e e A,

Unit1.cpp |
-
#include <vcl.h>
#pragma hdrstop

$include "Unitl.h"

#finclude "ComibMLink3_S0ER"

#include "ComikLink3_SDE_Defh™
ff—————————————————————————E——E——————E—, -, ,—,.

ComiMLink3.dll 2} & cmcLoadD]l()?é‘—’F £ o] &3l =g 4= A== FormCreate I &
$82208 A2 el AT,

ComiMLink3.dll 3+ S cmcLoadDI() 85 o] &-5Fo] 2 =3t} emcLoadDI()S 37} 8= W &
FormCreate & %‘6H ?:_]' T Rom o= s =EHY T

[Object Inspector] — [Events] 5 2] OnCreate | 4] B &5 2 3

Object Inspector
IForm‘I: TFarml

Properties  Events I

Ordctivate
OnCanResize
OnClick
OnClose
OnClozeluerny
OnCaonstrained
OnContextPop

i
v e &

OnCreate ;I

OnDblChick

OnDeactivate

OnDestroy LI
|&I shown y

713 3-36 OnCreate Event 575} FormCreate 35~} 12

F74e FormCreate() 25 582213 F 5 3 ¢l emcLoadDI) 355 F7HHU T
B Unitl.cpp
Unit1.cpp l

|void _ fastcall TForml::FormCreate (TObject *3Sender)
{

crocLoadDll() ;

1% 3-37 emcLoadDIl ¥ F7}
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LA (%) o] 2Hd ﬁ}ﬁ Zr o] TRY W DLL S WA A S Unload A A oF 4 T
DLL ¢] Unload Al A& L2 (&) A A A 2 ekl S8 22 o] T8 5= Al el RE=A] o] Folx]of
iR cmcUnloadDH()O] = S B8 A o] Fof ) cmcUnloalel()'Eo_T 7} = e o1
2aun.
[Object Inspector] — [Events] 5 2] OnDestroy ol A Bl && ¥ 3FH T},
Object Inspector |
IFl:urnﬂ: TFarmi LI

Properties  Events I

Ondchivate -
OnCanFeszize
OnChick.

OnCloze

OnClozelluery
OnConstrained
OnContextPop

OnCreate FormCreate

OnDbIChzk

OnDeachvate

OnDestroy FormDeztroy "l - I
|All shown y

2933858 X 23] FHEA] DLL ©] WA A .2 UnlLoad 2 5 915 OnDestroy Event £} 85=9] 124

714 FormDestroy() %+ 58X 2 19

B Unitl.cpp
Unthppl

of\

7 o cmcUnloadDIL() =5 FU Yo

void _ fastcall TForml::FormbPestroy(TObject *3ender)
{

crclUnloadDll () ;
H

19 3-39 FormDestroy &5 &5+¢] %A1 % Q] UnLoadDll &~ 7+
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3.3.4 Delphi ' XAE §] 5k ohy

Botland/CodeGear Delphi = 3l g 7] 273 ¥ %1 Q1 Delphi 5, Delphi 6 2 Delphi 7, Borland Developer Studio
2006, 2007, RAD Studio 2009 B Aol 4] ComiMLink3 ¢] SlE]#lo]~ 34 Hb o] wj-$- FAlal7] wf o
A FREoEA IS S EHY T

TE WA Version)2] Delphi 914 ComiMLink3 & AMESAIH™ &2 A4S T3 ol vEoA]7]
LlE=nsie )

( Project Start )

ComiMLink3.DLLI} & 0|

1.DLLE SE& EXETI20| A= ZH

2.AER ANAE EZEM S, 2Y MM DLLE &2
% e R0l fIXIGHOF BHLIC

ComiMLink3.pas Il2 & T2 ME
S0l SAH

A

ComiMLink3.pas It S Project
Manager £ Soll Z2HE N FIt

A

iMLi it2 AEISOIES o _
ComiMLink3 Unéﬂ t&Jrsat Uses ComiMLink3; =2t

A

S

13 3-40 Borland Delphi ol 4] ComiMLink3 AF-§- 41 &

38



COMIZOA MECHATROLINK-IIl SOFTWARE DEVELOPMENT KIT

Delphi 7 & 7] 0.2 AW =g AFUth o ehila =)= 5ol oh& 7l 3h4 1) - o] Hofo &
J %Yt} Borland Delphi £ 4 3 g o

=
oo
rlo
e
ki
it
m)~
[o}

[
Ach
E

©2002 Borland Software Corporation

1% 3-41 Borland Delphi 7 3}

fu
2
[
il
Anj
2

ZZAE A2} Ao 91D|I0+ ComiMLink3 ©] Delphi & &8 QIE]FHo] 2~ 3td& =
AU o] 3de E3H0IX0F ComiMLink3 ©] DLLDynamic Link Library) 9} 12721 9] S8
2 7Tt o] ol E ¥ 0]5\_2 ol 3te] =& mhel el o)

S 5 o] Delphiyt= WA A 0.2 2 AES 7he] 4% ko] WQ
Dehphi 7 2t2}9] Bzl ol 4] B2 742 7124121 A A E o 7] Rkgk ] & A9 Sk TR AR 5
FUth 67 01 =0 ComiMLink3 o1l 413 Delphi ol thgh 3 5-3F ol 4] & A &3}aL 51Ut

MZE TR AES A 4st7] e, wl57e] [Fidg-[New] BHES &all, =& & T=a9 /NS

A A

7 New ltems E|

Intraisfeb ] WebServices ] Business ] WebSnap ] Web Documents ] Corba ]
He l.&ctwex ] b uiltitier ] Froject? ] Formz ] Dialogs ] Projects ] Data Modules]

-.@-3

Batch File Camponent Conzale
ﬂppllcatlon Application
F % O
Control Panel  Control Panel  DataModule  DLL Wizard Form L]
Application Module
s =] 1
Frame Package  Project Group Resource DLL Service
Wizard v
{ i i

ak. | Cancel | Help

1% 3-42 Delphi 7 &) Z2 A E A| 2}
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Z 2 A E 7 A AR 3 Aol Form1” 22 Delphi IDE 2] Projectl ©] YEFE Y T

AY o] 2 9 -S F71817] 98 2 0.2 [Project] 2] [Add to Project] & A1 1 gt}

Project| Bun  Component Database  Tools
Add to Project, . Shift+F11 |

Bemove from Froject, .. ]

) B e 8|1

Import Type Library,
&dd to Repositary,

View Source

Languages >
+ Add Mew Project,,,
&dd Existing Project,,,
1%} 3-43 Delphi -8 Q1B 7l 0] 2= s} =7}

od

OHI2E HSHSIH £JE 8 £ 2
&LICH

Z1¥ 3-44 Delphi & ¢8| 7| o] 2= 514

Project Manager Z E3f 3ol ¥ ComiMLink3.PAS o] T ZAEo| E25 AL

%0,
bl
°
A

o
r

PE Project 1.dproj - Project Manager

B acivate v ZEnew oF @
File
E5 ProjectGroupl

@ 4 Build Configurations
& ComiMLink?. pas
= Unit] .pas
[ Unitl.dfm

1% 345 Delphi & Q1 #| 0] 2= 9} & T2 A E wlj] Aol F7}

Delphi ©] ComiMLink3 Q18] 7] 0] 2= 3} o] A}-g-of] o &k 77} 2|
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A 8] G717 Z0}2] ComiMLink3 2] ComiMLink3.pas ¥+ & Th2 7|3t
damL4W”””itﬂ“itﬂﬂioiﬂfﬁéqﬂl

DIL o] 2= U},

Mo

2 13 o] FE Al UnloadDIl ©] A 3 Y},

&8 Z 2% FEA0 UnloadDll 0] A H o2 555 4] ¢hotle AHe 4 o=

(VC++, C++ Builder) ¢}
&ﬂAﬂﬂﬂﬂvML

Initialization 2} Finalization = ©]-83F A 02 X 2 A E o HU}E [oadDIl < 3F §lo] A4 502

&

olo

interface

uses
Windows, Hessages, SysUtils, Variancs, Classes, Graphics, Controls,
Dialogs:

type
TForml = class(TForm)
private
{ Private declarations }
public
{ Public declarations }
end;

var
Forml: TForml:

implement ation
x’fff.ffff.-‘.ffr"fz‘.ffffffffffffz'f_.—’.fx’fff.f_/ff.-’.-"fffz’ffffz‘ff.fffffff.—‘ffffff
/7 COMIZOA SDX Library & H§ fleisfe)l= F & 4 EF 4,

TSRS RIS TR TSRS TS E SR r i iy

{5 *.dfm}

end.

21 Modifed It \ Code £Diagram |

Forms,

1% 346 uses TS -3l ComiMLink3 Unit AH-&-

-‘Hﬂ- o] implcmcentation Fol uses & 3] o] B F] Unit S AIET F ==

HEEA] A FAAL

APEre] uses o ANstol LT olF, Wate] oA the Auu
N3o 5 Sl

TU3HA DLL 2ol B g &
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3.3.5 Visual Basic 7Z#= 93k ol

R}

i

Visual Basic 6.0 & Flo]|ARATES AFTHE 7|9t L2 x2 730 /s 93] gojd Yol 7
37 ) Ut} ComiMLink3 ¥ Visual Basic 6.0 & £+ 3] 2] 43&}, ¢1E| 7 gl S AlFsta dFYTh
el

lﬂ
El

O~
isual Basic L H= = g8 A =l Hod= =
Visual Basic 3172} (#1%)2 S 7141 |IZZ O e HGS =279

AA et Az

#13] @AH0IEOk=

21 A Visual Basic 6.0 ¢] Z2AE A2 Ao T2 AE t]HEg o H0|ZEOF ComiMLink3 21 F o]~
92 2] ComiMLink3.BAS ¥} ¥} ComiMLink3 ¥ ‘ComiMLink3.dIl’ ¥ % HlEA] Z 2 AE o Eg o
AL A 7] vpEy T}

< Project Start )

ComiMLink:
LibraryS S

ComiMLink3.DLLI} ! 0|

1.DLLS S =&HEXELIZ20l U= 20

2. 22 AAL BEC S, 2SI DLLE &S
l « 9l ROl IXI3HO0F BLICH

ComiMLink3.Bas I} £ At

A 4

Visual Basic 2| Project il =S S
ComiMLIink3.BAS It s T2 M E(f
=t

[Project] — [Add File]

4
|
i)
1o
f

)

1% 3-47 Visual Basic 91 4] ComiMLink3 A& <A &=
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Visual Basic = A 8 & T}, Visual Basic ©] A1 2HEH oS3 22 Al T Z A E shH o] A E U

Mew Project

Mew | Existing | Recent |

ActiveX EXE  Activex DLL Activel VB WB Wizard
Contral Applicat,. Manager
BB B B B
Activex ACtiver Addin Data Project DHTML s
Document Ol Docume. . Application  Application ;l

= > B N &N

72

EERH |

oo |

I~ Don't show this dialog in the future

I3 EE ZRAE Y

Visual Basic ] ™8 ComiMLink3 #| - A}8F-& of ] &1 7}»

AAE=A A 8 &

ComiMLink3 &= NET 27 ] Visual Basic 7}4] A& 8} 1554t}

53] vlg] 744 F ComiMLink3 18] #] 0] 2~ 342 7k
ComiMLink3 & A}2314 Q5= =98 =a1 )

WFF Visual Basic A& 117 EE%)”’A] 4] ComiMLin

Agle] =2 S ek =gy,

3 ZRAEo] 7}k s A A, vl
o).

ojg] %ol
7] uhgt

F

n‘.l)

AoA T,
o A S o

Y
K3 AH8-el
EIA T ok A A A DH o2 AFA

Alﬁuix“E ol A Standard EXE’ & &3 5 S8 Z 29 LS AU Th A7 HES
FUth wkek o] swio] LA ko ofbg o] st 3} o] File W] 2] New Project’ 35S %3

N EEAES A,

Dgpen F‘rnject...

Ctrl+0

&dd Project,,,
Rernoyve Project

E Save Project
save Project &z,

Save

save As,,,
Saye Selection
Saye Change Script

Citl+3

&5 Print,,,
M Print Setup, ..

Cirl+F

fake, .
IMake Project Group,,,

Exit

Alt+Q

T 349 Al ZRAE ] A2
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A ZHE ¥ EXE &8 2273 7 v 5

fisual Basic [design]

o A ofel 1 3} 7] Project W77 E 53 ‘Add File...” &

w | Project Format Debug Bun Qu

&5 15 Add Form

= ¥ Add MDI Form

2) #2 Add Module

#1 Add Class Module

AF Add User Control

=] &dd Property Page

8] £ddl Wser Document
Add WebClass
Add Data Report
Add DHTML Page
Add Data Environrment
More ActiveX Designers.., » [

Bernove Formi

#4 Feferences, ,
Components, ., Cirl+T

Project! Properies. ..

9 350 LA Eof QIE Ao] = el & Fhal7] 91 94

B

Visual Basic

ComiMLink3 bas
Yisual Basic Module

19 351 ZEAEo| F7} thAto] ¥ ComiMLink3.BAS 3+
ComiMLink3.BAS ¥} & X 2 A Eof] 7}3) A A T A] 4 91 ComiMLink3 2 =7} o] F0] 2] ] ¥ ™
Visual Basic &] T2 A E || A] A A}-&35HA 4 95

Froject - Project =

= 1% Project1 (Project1)
=33 Forms
=QForm 1 (Form )}
=53 Madules
¥ ComikLink3 (CormikLin

O9 352 L2 A Eof BEZ F71E ComiMLink3.BAS 3+
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M Home - Form]1 (Code)
|btnHome

j |[:Iick
" HomeSetCopfial Har & = 53 TS, EZCount. EscDist. Offset
Call HomeSetConfialGetactiveChannel, cmbHome.ListIndex, O,

1000, 03
" HomesetSpeedPattern &5 E8 H3 57 £z 5 23U
Call HomesetspeedPattern{GetActiveChanne!( ), cmSHODE_S, 10000, 20000, 20000,
" HomeMove(Ml & £, £ S7 &g, 85 HF

Call HomeMowel GetAct ivechannel, BetDirection, GetlsBlocking())

I
End 3ub
CE B A ZFEI ERY 2F =SELUL.
Private Sub BtnStop_Click()

Oim lsWaitComplete As Long
Oim nResult As Long

lsWaitComplete = True

1% 3-53 ComiMLink3 & 38 S8 X213 13

Visual Basic 2] ™ A] 2] 2] ComiMLink3 1 €] 3] o] 2~0of] tfj 3} 37} ot

ComiMLink3 o] ¥ Visual Basic & Q1E]#lo] 2 32 M= 9] DLL

2}o] ¥ 2] 2] (ComiMLink3) 2] 2 (Load) 2 912 E (Unload) 7} & §l55U ) whebA,
AAE) ] TR AE S Forml o] F7H QI so] 2 9t S Fato], & TR
TAE k= A Fsk A gl Tk

T e

45




CHAPTER 4 :: COMIMLINKS3 INTORDUCTION

ComiMlink3 Introduction

CHAZIS) S0} 2261 IS EfOSEE] T|ZIHES oY QA HESH0] Sl ComMLink3 =
H2[81 1810 AR S 8] A} HIOIS2 FIHe) SGIELITH G3/EE0F ComMLink3 ] 214
NS IS EE B 0] 7|22 2T FLYL 7 S AOIT0pS) Z|ZILICE KIF SO SHIAL

ol M= ComiMLink3 7} Al &&= 2ho] Boej 2] Q1E s o] 2ol th gk 2pAI gk A v )&
P U ComiMLink3 = 2o Befe] 7|55 Btk FHsta g&4 o= A e o 9=
L. & DB Run-time) Q1E F| o] 29} 2ho] B ] 2] o] T3l 7] 5-& A A= (EHl) &=
Als gt 2 vl 2ol M= ComiMLink3 ol A #l)-&-8}= 2ko] B.2f 2] gl th et v (@)=
75l mek e R eSS iG U o
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ComiMLink3 47}

ol

S0l gy R
ComiMLink3 | 4] A|&8h= B 4= o
o] scmerol eh= ol 7k B4,

cmcLoadDI(), cmcUnloadDIl(), cmecGnlLoadDevice (), cmcGnUnloadDevice (),...

T3 eme” O] R el Y Fvk S3he 7150 1FS ESHE AFoI/E olelHnh,
S B ol FUL N 1E H8 AHEE A7) Y 5 9w, B} 2= we] w0z
Ao AUHnE §U A5 gl 48 el P el 5 gl ) AU,
oFeli= 8 71K 7% 1§ ESHE Aol 4 88 Fe sl g,

O. General Functions (Gn): cmcGnloadDevice(), cmcGnSetServoOn (), ...
O. 874
O.
O.
O.
O.

J

ot

55} o]

i

API

i

o] 5= AL W5}7] $I5te] o}l oo}

A 35 (Cfg): emcCfgSetMioProperty(), cmcCfgSetSpeedPattern(), ...
& 3F

T

S
=]

ol

d
W
1

,?_

(o
)
o

(Home): cmcHomeMove(), cmcHomeSetConfig(), ...

d
i

A%y
H
offt
)
e
ot

= (Sx): emcSxMoveStart(), cmeSxStopy(), ...

oft

i
Y
i

il

I~ =
T=
A~
T
TE (Mx): cmcMxMoveStart(), cmcMxMoveToStart(), ...
PN

=

fr &
T

-
oft

i

?_

ot
ok

il

(Ix): emcIxMapAxes(), cmcIxLine(), ...

dioles 201

FAFS] ComiMLink3 $1E]#| o] 2= wlii7 Aol A A %9 <& Dynamic Link Library & A1} o &

N @AM AR TFe du T kARt dlolEf el that o] 52 /NEede] webd M2 gayth
wpepA 2 el M= E*]O]HJ d 715 B 73 o] $dste] 71Tk ool g 2 3yt 9
H&¥ = HolH g %71+ B 78 Fxsho] ARS8k 7] vyt

aar £ wfrdel = “fin) “lout]” F71E ARESte] iy ST el deE s Q1A ofy W
deen AUAE GAHRG G Bl RS ARV AU, e FEERE RS
A== 23S vyt o, 01 };7]% ol ARt AbgE = Zlolw, Al ekl =
F7)50] QA Y

Data type Description C/C++ VBG6.0 Delphi C#
VT_EMPTY %‘r%}Ol Sl ol 58 g void - - void

YA EARZ AEE 4517

VT_HANDLE -r]oﬂ/\i w5 a] o] X5 A n void * '(‘E?”gef) THandle  IntPtr
D20 2L 1f WE Y
o] =] = L
VT_l4 4WlolE Bool= 44 Hd Y long (é);\?al) Longint Int
4nfol E B 9l= A W] 4 3k . Long
VT_Pl4 (EQH) £ WA F s T3 long (ByRef) PLongint Int[]
- 2= Double
E H5 ol A2 w ] E
VT_R4 4HlolE B ole= A4 13y float (Byval) Double Float
4vbolE B39\ = A HFo] T4 . Double PDouble
VIPRE e EEaTs 5EY 1037 (ByRen fload
. s Double
HIO|E B35 9] A2 133
VT _R8 8HO|E Ro9v= A 1dd double (Byval) Double  double
VIPRE  Buel= Rmgle Adugel fa (0P PR PDOUNE qoupiep
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F(ELE) == wldFa 13
A e gl FA4E A FaE . String .
VT_STR A A B 4 Hl O] E 2 13 char (Byval) PChar String
F7do15HA volE 27] 2 7 Ao & dlolH @
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Chapter

General functions

FZ{0|Z0RE ComMLink3 £ &3ff LFEfat 241 7f2I2H-ES A2I817] £/of = 8ol QgL /rh &2 SojA

rpEA ¢

& SIZ2 OJB3IAE DI HHATE AZ] 57/0/Z0FE & Z2Jof7A/H £1%3]

[pS CE/ER SO0, FBE/E 2H0/222 LIEHOAS S ot Teokn WEH
20|22/ AHSE 7+ LU= 2 A LISH0] £ EIL/CHHOI 52 2[PEO 2 B ComiMLnG 2/0/E2/2/o]
S22 Ol B SHYAI2

O

)
et

G M= Ao mE/ARE e AR x7|stet ddd b dubAl daes
2N A @) A EEAAME SelB el o 27]8te} AHES A= HkEA] 2
T HoAFA] eyt A E s el ComiMLinkd & 2= B ARE, )

WA B (Parameten) 22718} B Bl HEO] A 2] Ml Resen ol ThEE 852 74 5] 5 Hh
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5 General Functions
54 & Qo

Summary of Functions ‘

0 BOOL cmclLoadDll([none] VI_EMPTY)

gtol B e 2] & ARG AH(f I #) &8 2 2 1R o] AFE-S 913l R = (Load) U T

O VI_EMPTY cmcUnloadDIl([none] VT_EMPTY)

ghol B el g & ARG A ) S8 ZRIAH] AFE TR 1)E 98] A== (Unload) FH T
O VI_HANDLE cmcGnloadDevice ([in] VI_PI4 NumDevices, [out] VI_PI4 BoardIDList,
[out] VT_PI4 NumServos)

grolB 2|7t =g oM A E 25 (Load) 3h= 9 2= Tyt

O VT_I4 cmcGnUnloadDevice ([[none] VT EMPTY)

ghojB el g7t =g AEjol A A& AR E(Unload) 8= &5 St

0 VT_I4 cmcGnResetDevice ([in] VI_I4 BoardId, [in] VTI_I4 ResetMask)

9 BAel ARES 2750 A ee g,
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52 &4 &Y
NAME INFORMATION
"7 General Function
cmclLoadDll # VC++/BCB/ NET
- gto|=&{2l(Library) 2E Level 1
© 99 828
0O BOOL cmcLoadDIl ([none] VT_EMPTY)
DESCRIPTION
ComiMLink3 & A2 (H%) 22 S&Z 2o vng gt &3t} o] ouj= o]
St &2 E = 47 golryE = 5_’7“(%1%)”«] T2 aAYE EFAEH 22T A

AT of g AA@EE)'E o A Z2 el A ComiMLink3 & AFHE-3}7] 18
FeorAE 7P HA SEHolok

o] e4=0] Al LT} TZof| 9o, Al TE GAN Fole] 34 dlY 3+ o A= Boland it 9]
Delphi Y Microsoft jil: ©] Visual Basic ol A= H A] & O & o] 5 #}o] o] Fo] =] 7] wfj o
295 ST,

RETURN VALUE

o] 2’3k & 3 Boolean Type) = 74| 2L U5 Y T}

Value Meaning
cmcFALSE DLL & Z=38l=d A &S o vy,
cmcTRUE DLL & AFTA4 o2 2T S-S v}
SEE ALSO
cmcUnloadDIl
EXAMPLE
C/C++

#include “ComiMLink3_SDK.h”
#include “ComiMLink3_SDK_Def.h”

void StartProgram(void)
{
// °] ¢ ¥tEgh2 DLL ¢] 2=9] JF o5& vt
BOOL nlIsLoaded = cncLoadDI1();

void EndProgram(void)
{
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// ©] o] REgkgke gl yth kA bE A g H e shA] 54
cmcUnloadDIL();

52



COMIZOA MECHATROLINK-IIIl SOFTWARE DEVELOPMENT KIT

NAME INFORMATION

["=7 General Function
cmcUnloadDlI # VC++/BCB/ NET

- 2to|E B4 2|(Library) 2= S M| (#EBR) Level 1

© 97848

SYNOPSIS

3 VT_EMPTY cmcUnloadDlIl ([none] VT_EMPTY)

DESCRIPTION
ComiMLink3 & I (&) d o] &2 1519 w& ] bl A s A F ). o] &fn]&= o]
47t 3EEHE AN ZEOTY] ComiMLink3 ¥ L2 (F) D 9 &8 2 13 o A]
AAGYU. o] e A (%) H Q) AA| 2o A ComiMLink3 2 A4S £ 8 317]
ek o ZAE 7MY sl SE 5 ofoF
o] g0l AME- I B Zol| Qlo], AT H @AW Foto] FHr &l 3H Y ol A = Boland it €]
Delphi U Microsoft Jit: ¢] Visual Basic ol A<= WA & 0. & o] FZo] o] Foj 7 = Q==
TAE ] Q7] Wit F oA gyt

SEE ALSO

cmclLoadDIl

EXAMPLE

C/C++

void StartProgram(void)

{
// 0] B4 ) Wakgke DLL o) 2 o) Agel i wakghth
BOOL nlIsLoaded = cncLoadDIl();

void EndProgram(void)

{
/7 °] @9 v ge syt mEbA e d g A g 983kA dsyth
cmcUnloadDIl();
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NAME INFORMATION

"7 General Function

cmcGnLoadDevice # VC++/VB
- x|'7t|(;'* ) 2= (Load) BCB/Delphi/ NET
Level 1

© A9 arge

SYNOPSIS

O VT_I4 cemcGnLoadDevice ([out] VT_PI4 NumDevices, [out] VT_PI4 BoardIDList,
[out] VT_PI4 NumServos)

DESCRIPTION

Z718k3t T}, o] 347+ ComiMLink3 9]
];zquq_ ohﬂ]—ﬂgi :’:i:’f”tﬂ.ﬂ

[¢]
-

A=

A 2Eo| A9 sl=go] AXE 2 al
b= T 5

e ) 528 7] Aol whe] sl
AR RS PUPSE St i)

_Q,ﬂl

flo

o gho] A Tl ol AlEE @AM Foke] g4 ST Visual Basic ol A= &9
A5F0] eme 7k 24 54T

PARAMETER

» NumDevices: 0| W] 7| H T E 55 AA 22 = (Load)g HEYIRH R =742 0k3kgy
ot ol uf 7 W ol NULL S 3 @b B =) =5 9h8hal <] & & ot

» BoardIDList: 0] Wl 7§ A & St A A A 2 2 & (Load) AU EH AR A R = 9] 1D
vl S ek ghy u) o O] uH | 4=oll NULL &4 23std R = 1D vl G &nkglal A ek o),

» NumServos: 0] U} 7| H =& 5 3} o] A A 2 2 = (Load) F A B.=2h o] H o] /| =& Hke g o},
o, o] e 7 WA ol NULL & EalH A o &Rk sk« ef 5 o

RETURN VALUE

Value Meaning
=T & A A W82 ol A2l HE Fadyn
ERR_NONE S

SEE ALSO

cmcGnUnloadDevice

EXAMPLE

C/C++

#include “ComiMLink3_SDK.h”
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#include “ComiMLink3_SDK_Def.h”

void ProgramInitial(void)

{

long nNumDevices = 0;
long DeviceList[16] = {0, };
long nNumAxes = 0;

if (emcLoadDIl() 1= TRUE)) {

/* OutputDebugString API == GUI £ X Z A ExLE S o Ao B S 915 Y o) Borland
C++ Builder Oﬂ A= DebugWindows o] Event Log & Q{?l(ﬁf& uE)%}' T Yo MSVC+H+ o A=
Debug 91 =-5-0ll A FRA(fifEF2) e = A FH T */

long BoardID = 0;
OutputDebugString(“DLL Z =0l 2 9| 3} 9 54 th);
/] o1F AAg e A g & A1 7] vhE Y

}

if cmecGnloadDevice (&nNumDevices, DeviceList, &nNumAxes) |= ERR_NONE ){
// NEHAIA] &
}

} /* ProgramlInitial(void) 32 & */

Visual Basic
“ Visual Basic 9| 4+= " A 4 9] DLL 2 =7} 2.8 gl
Private Sub Form_Load()
Dim IRetVal As Long
Dim nTotalDevices As Long
Dim DeviceList(16) As Long
Dim nTotalAxes As Long
IRetVal = GnLoadDevice (nTotalDevices, DeviceList(0), nTotalAxes)
If TRetVal <> ERR_NONE Then
MsgBox(“cmcGnlLoadDevice has been failed”)

End If

End Sub

Delphi

//* Delphi o A= WA 4] DLL 2 =7} F 8 gl5 4t

[/ A A AA ol vkt 22 o] E3tE oo T
I11171077777771717177777717171777177171717111771717171111117
// COMZIOA SDK Library & 93+ Q€] 9| o] 2~ 3} & A8 o},
uses ComiMLink3;
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T 7170777777 77777777777777771777777
procedure TForm1.OnCreate(Sender: TObject);
var

g nDevs : Longlnt;

DevlList : Array[0..15] of Longlnt

g nAxes : Longlnt;

begin

if (cmcGnLoadDevice (@g_nDevs, @DevList, @g_nAxes) <> ERR_NONE ) then
begin

// eNEHAIA EE

exit;
end;

end;
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NAME INFORMATION

"7 General Function

cmcGnUnloadDevice # VC++/VB

- M x|(#E) 92 = (Unload) BCB/Delphi/.NET
Level 1
© AR ergle

SYNOPSIS

3 VT_BOOL cmcGnUnloadDevice ([none] VT_EMPTY)

DESCRIPTION

SEE ALSO

A28 A H stEgo] A E ARt FRALS FaFUL) o] s
ComiMLink3 ¢ 3= A28 E7317]) Yol HA 4 o2 T ofof
Tzl FREFENA S5 Fuh

[*]

| &) A3 S E o 3o, AlFE @AM Zole] &4 3 Visual Basic ol A= 9]
A5 eme 7F B4 54U

cmcGnlLoadDevice
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NAME INFORMATION

"7 General Function

cmcGnResetDevice # VC++/VB
- oM ™MeE EIéi'(Reset) BCB/Delphi/ NET
Level 1

© 9¥axgs

SYNOPSIS

O VT_I4 cmcGnResetDevice ([in] VT_I4 BoardID, [in] VT_I4 ResetMask)

DESCRIPTION
o] s A o] FAI Y AR ES 27|85t YUt © 5, Bt 2| ~E B W
EE S5 ARE A, &5 985, A, WA, AT E g EY A QLG UES
Z7183 Y
o] g9l A8 T & o, AlFH @A R Z0te] 4 Y Visual Basic ol 4= 9]
A5 eme 7F B4 54U

PARAMETER

» BoardID: A8 A7} A A $F t]nfo] 2 (HE5) ID.

P ResetMask: 2] A AF A~ = gk YT},

Value Meaning
0x1 =& RS _SX_ENV F o] %o )3k mh A gyt
0x2 =+ RS_IX_ENV B7F o] 4ol i3k mp~ )
0x4 == RS_LM_ENV ZAE ZAH et v~ T 7kl Y,
0x8 == RS_SPEED _ENV 5o o8k vf~3 gy o).
0x10 ¥+ RS_HOME_ENV A EAol gk v Pt
0x20 =+ RS_POS_ENV Yol i3k vt YUY BE £ Y2 g Agy )
0x40 =+ ul 3 nl 2~ ol
RS_BACKLASH_ENV Hef Aol e vk gy -
0x80 T+ AT E RS 3} ml o ol ]
RS_SWLIMIT_ENV SEE RS theh vk gy o
0x100 == o1 .
RS_UPDATE_INTERVAL_ENV | ™ o1& F718 2713 T Defaule: 1 msec)
Oxff T2 ALL_RESET 9 EE EES gAetE viAa g ych
RETURN VALUE
Value Meaning
=5 53 Ao A &S g A AE Fauguyo
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| ErRrRNONE [+a 4%

Example

b5 ol g AE BAHS 2] AE Al ResetMask #h2 0x5 7F H Ut}
AdAEFAG &= 2 gAE A] ResetMask 4F2 0x18 ©] F LU T},
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Etc General Functions

o

"
S
=

ComMLink3 = 7|2 g+ 0[Q/0jl= Z/Ef 72 S+~
IfsoEAE GUI BIEOIN B49] FK 2 &
DHYEHEO SETZIYNN AL +

JIEE0] 22Bi%) Z/cta)a QLo

=

/=
AT

LIES
o= =

= el HEA 55

=
=

H X
s -/l_

7€} General () ES &
S5 2
[o) =
A H

General $F HOo g A o]

StAO

KEIZHLICE O] B0 BB FE ST

o B2 SRS T HHHH2 A

JI&EILICE O[2/o)= Lfefet el Jl&af P2t

= o

T} 71E} General $H7
Ao giAuE A Ao =
Yt} 72221 A H ON
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6 Etc General Functions

I-_J'\_ RQ'I:

ol

6.1
Summary of Functions ‘

O VT_14 cmcGnSetServoOn ([in] VT_I4 BoardID, [in] VT_I4 Axis [in] VT_I4 dwlsOn)

A B =2}o] H o] SERVO ON A5 &3 & A7FGEEW) 52 XFeh ik o

O VT_I4 cmcGnGetServoOn ([in] VT_14 BoardID, [in] VT_I4 Axis, [out] VI_PI4 pdwlsOn)
A K=ol H o] SERVO ON A& &2 (1)) Al & wkghaiss) o),

O VT_I4 cmcGnSetAlarmRes ([in] VI _I4 BoardID, [in] VI_I4 Axis)

&5t 2] Al (Alarm Reset) 21 & &2 (1)) & Alo] g oh

O VT_14 cmcGnGetAlarmRes ([in] VT_I4 BoardID, [in] VT_I4 Axis, [out] VT_PI4 1sOn)
o5 2] Al (Alarm Reser) A1 & Z = (1)) & 918 Alo] AA S WH3oE) Fu T

O VT_I4 cmcGnSetEmergency ([in] VI_I4 BoardID, [in] VT_I4 Axis, [in] VT _I4 IsDecStop , [in] VI_I4
IsEnable)

A ol vl e e Al vl 9 A4 G,

O VT_I4 cmecGnGetEmergency ([in] VI_I4 BoardId, [in] VI _I4 Axis, [out] VI_PI4 IsDecStopped , [out]
VT_PI4 IsEnabled)

S Fol that 2L EL oA Q1 g &= el & Wk o

O VT_I4 cmcGnSetEmergencyAll ([in] VI _I4 IsDecStop, [in] VI_I4 IsEnable)

SEZE oA v S AR @D T

O VT_I4 cmcGnGetEmergencyAll (Jout] VI_PI4 IsDecStopped , [out] VI_PI4 IsEnabled)
2ZES o)A B G a FE S W GE) S o

O VT_I4 cmcGnSetCommPeriod([in] VT_I4 BoardID, [in]VT_I4 nPeriod)

T el E 718 AR E0E) T

O VT_14 cmcGnGetCommPeriod([in] VI_I4 BoardID, [out]VT_I4 nPeriod)

A fHelE 7] E vk cliE) g vk

0O VT_I4 cmcGnSetStatusUpdatelnterval ([in] VI_I4 BoardID, [in] VT_I4 dwlnterval)

AN E ol E 1S AR Ut

O VT_14 cmcGnGetStatusUpdatelnterval ([in] VI_I4 BoardID, [out] VT_PI4 dwlnterval)
ARG JH Ol E 52715 vhRkiE) F Tk

O VT_I4 cmcGnGetAxisMap ([in] VI_I4 BoardID, [out] VI_PI4 AxisMapMask)

AAdw Lol v A1 E vkkikig) g ol

0 VT_I4 cmcGnResetComm([in] VI_I4 BoardID)

FA1E 2718y

O VT_I4 cmcGnSetCommStates([in] VT _I4 BoardID , [in] VT_I4 Axis, [in] VT_I4 cmctsld,
[in] CommStsVal)

A HE AR EGE) FY T

O VT_14 cmcGnGetCommStates([in] VT_I4 BoardID, [in] VT_I4 Axis, [in] VT_I4 cmctsId,
[out]CommStsVal)

SAGEE W) S o

O VT_I4 cmcGnSetParam([in] VT_I4 BoardID, [in] VT_I4 Axis, [in] VT_I4 PrmNol, [in] VT_I4
PrmDatal, [in] VT_I4 PrmNo2, VT_I4 PrmData2)

g Fof ME st g E A @) T o
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O VT_14 cmcGnGetParam([in] VT_I4 BoardID, [in] VT_I4 Axis, [in] VT_I4 PrmNol [out] VT_PI4
PrmDatal, [in] VT_I4 PrmNo2, [out] VT_PI4 PrmData2)

S o) A n shebelE & WG T o

OVT_14 cmcGnSetLogMode ([in] VT_I4 LogMode)
28 7|28 v S XA S o)

O VT_I4 cmcGnGetLogMode ([out] VT_PI4 LogMode)
205 7| S ek g & wag

0 VT_I4 cmcGnSetLogLevel ([in] VI_I4 LogLevel)
257152 7% dEs AT

O VT_I4 cmcGnGetLogLevel ([out] VT_PI4 LoglLevel)
257152 7)E dES wEgyh

Ovr_14 cmcGnSetFuncLevel ([in] VT_I4 Funclndex, [in] VT_I4 LoglLevel)
a5 el 22 s ARy

O VT_14 cmcGnGetFunclevel ([in] VT _I4 Funclndex, [out] VI_PI4 LogLevel)
AN B el AAE 2 el Mg g

O VT_I4 cmcGnRestoreFunclevel ([in] VT_14 FuncIndex)
AR el 2o 0e Qo M QR g,

O VT_I4 cmcGnGetNodelnfo ([in] VT_I4 BoardID, [in] VT_PI4 Axis, [out] TSlavelnfo *Slavelnfo )
T Fo Eeloln AR E wEkgy}.

O VT_14 cmcGnTotalDIOChannel ([in] VT_I4 BoardID, [in] VT _I4 Axis, [out] VI_PI4 Channel)
G FHoll JZ29 = UAE 1/0®nput/Output) A8 HFZ wkgleisa) g ol

O VT_I4 cmcGnTotal AIChannel (fin] VT_T4 BoardID, [in] VT_I4 Axis, [ouf] VT_PI4 Channel)
A FHoll AAdF FoldE 1 Y ‘?—:‘1(Analog Input) NE NEE ‘?1’51’ Jbél% gy o},

O VT_14 cmcGnTotal AOChannel([in] VI_I4 BoardID, [in] VT _ 14 Axis, [out] VI_PI4 Channel)
g Foll A4 H F o E 1 F 2 (Analog Output) A2 7H5E WHEHGR ) Y T
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62 & a3
NAME INFORMATION
"7 Btc General Function
cmcGnSetServoOn # VCi+/VB
cmcGnGetServoOn BCB/Delphi/ NET
b = =g4 Level 1
- ME S Turn On/Off &5 EZ(H ) Mo | g o
o] g
M B Egto]H ol F2h&
%1% ON/OFF A H &
AAgH T A E
FZA o] HEEA] =]
#78S AAstka, A
Aol -] 3l of F .
3 VT_14 cmcGnSetServoOn ([in] VT_I4 BoardID, [in] VT_I4 Axis, [in] VT_I4 dwIsOn)
O VT_14 cmcGnGetServoOn ([in] VT_I4 BoardID, [in] VT_I4 Axis, [out] VT_PI4 pdwIsOn)
DESCRIPTION
cmcGnSetServoOn() g% A4 3k Al 9 (F)9] SERVO-ON 21 & &3 & Aloj ok A 1
EafolH & ARG wl = o] ol Al 29 2] & o] &-3fo] A K. Eglo] B &) ON/OFF & Ao &
QX = &1, o] 2 SERVO-ON 4l &2} gt} o] 34 SERVO-ON 41 5. 9]
ON/OFF & Alof3st= S vt
cmcGnGetServoOn() &< @A 9] SERVO-ON A1 5 9] &8 A e S ukgkgh ),
o] g4=9o] ALE I TE | o], AT H @AM Fote] 34 3|l Y Visual Basic ol A= 9]
A5 eme 71 BA] F5U T
PARAMETER

» BoardID: A8 A7} A A §F tlnfo] 2 (HE5) ID.

P Axis: Axis U (F W& 3 FE Ay,

et
10
o
L
i
v

P dwlsOn: cmcGnSetServoOn 2] €1 z}o]| | SERVO-ON Al 5 o] &2 Alg)

Value Meaning
0 X+ cmcFALSE | SERVO- OFF
1 &=+ cmcTRUE SERVO- ON

rt
vl
°
o

Gl
rE

P pdwlsOn: cmcGnGetServoOn k2] el xlo] B SERVO-ON 213 9] =2 4 e

Value Meaning
0 X+ cmcFALSE | SERVO- OFF
1 &=+ cmcTRUE SERVO- ON
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RETURN VALUE

Value Meaning

IR o) Aol AT U g2 ol A e BE Fugylch

ERR_NONE TP AAF

REFERENCE

O A HE On Al AHOF 3= 7§ ecmcGnloadDeivee () 3 % ©] %l cmcGnSetServoOn
[}

(BoardID,Axis#, cmc TRUE) S =8l M oF A1 R H 7} A4 &2t gyt
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NAME INFORMATION

"7 Ftc General Function

cmcGnSetAlarmRes # VC++/VB

cmcGnGetAlarmRes BCB/Delphi/ NET
- Level 1

- 22t 2|All(Alarm Reset) 215 E24(H H) © szl

M| o4 (i 4)
SYNOPSIS

O VT_14 cmcGnSetAlarmRes ([in] VT_I4 BoardID, [in] VT_I4 Axis)
O VT_14 cmncGnGetAlarmRes ([in] VT_I4 BoardID, [in] VT_I4 Axis, [out] VT_PI4 IsOn)

DESCRIPTION

cmcGnSetAlarmRes() st A1 43 A d (59 &9 2l Al Reset) =22 Ao Th A B

ZeholH & ARG W= o ol A A E A A S o] &aho], A Eol A A A kS

Z713F & AL F AR =gto]lH Aol A g tstke Y AlE Tt SRk Eﬂ o] A&
Aol Eﬁﬂé}ﬂ e, B HEoM =72 ow Ay e YA 29 45 E 3 vAd

=Y 25 E B ], o] A E ¢ 2l 42 S (Alarm Reset Signal) 2} U T ©] 3HrE

tll HEOﬂ A dEhs e A A ‘Rlﬁq‘?}. agan FA Al Al I = A A S
AME EAA gholl Yo H3th

o

| o] AFE-3 S Z ol Qo] Al 35 @AW 2ot 3 3Y Visual Basic o A= 3]
A F0] eme 7} B ek )

PARAMETER
» BoardID: AF-&2}7} A4 8k t]nlo] 4~ (8 =) 1D,

P Axis: Axis HE (5 W&+ 3 5E A2y o).

P IsOn: cmcGnGetAlarmRes $<=2] ¢lxlol ] &2 A& wragd Ut &9 Ad = oS3
2ol Wk o,
Value Meaning
0 (cmcFALSE) | &9 izt vl &-d st eyt
1(cmcTRUE) | &3 Ael7} g4 3l Jeid Yl
RETURN VALUE
Value Meaning
&5 ol A9 AAD gL oA Ae BT

ERR_NONE | 43 A%
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NAME INFORMATION
"7 Fitc General Function
cmcGnSetEmergency 7 Ve VB
cmcGnGetEmergency BCB/Delphi/ NET
- EI_ > - — o _I I‘ I';I' Level 1
- BT ol CHE AZES oIl HIAAME o s
X0

SYNOPSIS

O VT_I4 cmceGnSetEmergency ([in] VT_I4 BoardID, [in] VT_I4 Axis, [in] VT_I4 IsDecStop , [in] VT_I4
IsEnable)

O VT_14 cmcGnGetEmergency ([in] VT_I4 BoardID, [in] VT_I4 Axis, [out] VT_PI4 IsDecStopped ,
[out] VT_PI4 IsEnabled)

DESCRIPTION

cmcGnSetEmergency() 3+ 2 E o] A 02 HMHAEE Y 9] Axis F& Emergency & Hl =
AU A A (1R A7 HA RARES = @A AT A
AAEF 1) FUTh BB A (1) 7 24 8t o] e Eetol = ol s Ee] £&

Zhgd o] A= Ytk IsDecStop P78 =W ra# ol whe} v A & &5 5 A E
Ty

cmcGnGetEmergency() & A EEZH 9] Axis 52 2ZE 9] 4 ] Emergency 3 El &

wEHg o,

o
sl
4

]

o] ghro] A8 T Fof o], AlEH @AW Zok] 4 Fl Y] Visual Basic ol A& &9
HFo] eme 7} X &St

PARAMETER
» BoardID: AH-8A}7F A 78§ tiufo] 2 (XH =) ID.
P Axis: Axis HE(F W&+ 3 5 A2 ).

» IsDecStop : IsEnable & "I 77 emcTRUE 2 A GEE) S H A =1 Qe B
24402 A P )3 BT o9 A (1) Al o A (1 1) SRR 4

A (5 1) AN A S AU T} & IsEnable W7 ¥ = (A 8580 7} emc FALSE ©]
AAA D S A FElE 2 stelA Hue, 2 v ae] A g FAE Yo

Value Meaning
0 =& emeFALSE | 8 A (% 1k) (5318
1= emcTRUE | &5 AA (L) FEms A 2 Sz 449 4455 48

> IsEnable : 2232 E o] 2 1 W] /gl o] o] & /Mg FHlE AT

| Value | Meaning
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0 %=+ cmcFALSE

1 =+ cmcTRUE

» IsDecStoped : 33 55 9]

Value

0 %=+ cmcFALSE

%92

AR (1l (G

=]

1 =+ cmcTRUE

FAA I @EEE A 4 F92 A48 455 48

4

=

P IsEnabled : 22 E 9o} A ¢] H]

Aol o] 2 /ml e e s nEFy

Value

Meaning

0 ®=+= cmcFALSE

Aol B2 (82 )

1 =+ cmcTRUE

A o] 2

RETURN VALUE

Value

Meaning

O 2=
T

ARAIRE S ol A ) A S gy

ERR_NONE
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NAME INFORMATION

"7 Ftc General Function

cmcGnSetEmergencyAll # VC++/VB
cmcGnGetEmergencyAll BCB/Delphi/ NET
Level 1

X-|7<0-|| |_'_Ho|- AITIES |0-|7C-IO| |:|| AFA I-%I- X‘”O'I

© sdex el

SYNOPSIS

O VT_I4 cmcGnSetEmergencyAll ([in] VT_I4 BoardID, [in] VT_I4 IsDecStop , [in] VT_I4 IsEnable)
3 VT_14 cmcGnGetEmergencyAll ([in] VT_I4 BoardID, [out] VT_PI4 IsDecStopped , [out] VT_PI4
IsEnabled)

DESCRIPTION

cmcGnSetEmergency() 37+ RZESo] A 02 HHAAEEY A5 S Emergency 3 E =
AUk v A ¢ k) BE7E EH RARAES Y = dA g A4S BT
AA 7 1E) FU ek vE A A @7 1) 7 EAd st o] = Bt ol sHE o]l EEH =
2k} o] A=FE YT IsDecStop M 7l WA s g of] whef v)d A =2 1H4 & AXE

g
ecmcGnGetEmergency() & EHAAEEZ Y A5 t) g AZE o 42l Emergency A EHl &
Braka o,

o) 952 283} 5550 )

o] AlFE @AM Zo}2] 3+ 3| H Visual Basic ol A+ g2
A7 eme 7F A &5 U

PARAMETER
» BoardID: AF-8-AF7F A A g t]ulo] ~(H.5) ID.

P IsDecStop : IsEnable o W 7l 47} cmcTRUE & A H (Eiﬁ)ﬂﬁ A FAEHL Y= RE
22> A (e ik)yskA HU T ol wll A A (5 1) Al o l;ﬁxl (= 1k) FAJNA 55

A A] ({?’JJ:)UL X & AT} o, IsEnable "] 7] ¥ ﬁ%ﬁ@%ﬁ)ﬂ' cmcFAILSE ©]'d

AA Al v A AX] A E v A3 LA HlE R B usHage] AF gke EaAE YT

Value Meaning
0 T+ cmcFALSE | S8 A (1) (35819
7

1EEecmcTRUE | 45 AX (gL @EEE A4 &4

Sy
u

>
o
o
P
k
%

P IsEnable : B4 =] (5 1) 2] & /8] &4 Jel & A A o

Value Meaning
0 B cmcFALSE | B2 A A (e 1k ¥l 2Hd (4 el
1= emcTRUE | WA A (f k) B4

P IsDecStoped : 33 o] HIFAA] A HAA LA & 5 FA QAo hHaF Fejate

HEk g o,




COMIZOA MECHATROLINK-IIIl SOFTWARE DEVELOPMENT KIT

Value

0 & ecmcFALSE | 48R (17 1h) (F&8l+)

==

1 %= eomcTRUE | #55 AA(deih) s @4 74 FH2 449 345 48

» IsEnabled : U737 2] (15 1) o] &40 /0] &4 el & wEgk sty o)

Value Meaning
0 ®= cmcFALSE | HIZ A A (i 1ky B1 &4 (378 el
1%+ cmcTRUE | B8 A (1 1k) 74

RETURN VALUE

Value Meaning

=T T A ZA g U &2 ol g A e ds Fadh
ERR_NONE | 4=3] A&
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NAME

INFORMATION

"7 Ftc General Function

cmcGnSetCommPeriod # VC++/VB

cmcGnGetCommPeriod BCB/Delphi/ NET
J = 474 _ Level 1

'%AI_|/?=IE-”O|E lelAEngl_l-El- @ %@ﬁi%i%

SYNOPSIS

O VT_I4 cmcGnSetCommpPeriod ([in] VT_I4 BoardID, [in] VT_I4 nPeriod)
O VT_I4 cmcGnGetCommPeriod ([in] VT_I4 BoardID, [out] VT_PI4 nPeriod)

DESCRIPTION
Master 71 EZ 2] 9} Slave {F &4 7] % Slave X FHo|E 7| & AAF YT o] &
F3l 715 WA e $oll & REEA] Master 71 E &2 & Reset 3Foj oF M7 g 7|7} 4 &
e,
o] F422) AHg} B el 1ol AlF ¥ F7I vl okl $4 T Visual Basic ol A= #5e]
A7 eme 7F EA] 25U T

PARAMETER

» BoardID: AF-8-A7F A A $F tinlo] ~(R.E) ID.

P nPeriod : cmcGnSetCommPeriod 32| ¢1x}o]| ] B4l /Ao E 7|5 A3 A

Sag T A4 s o0 e e

Value(10nsec) Meaning
5000 500usec(0.5msec)
10000 1000usec(1msec)
RETURN VALUE
Value Meaning
g5 | FUAaANE EE el dg Bugi
ERR_NONE T A4
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NAME INFORMATION

"7 Ftc General Function

cmcGnSetStatusUpdatelnterval # VC++/VB
cmcGnGetStatusUpdatelnterval BCB/Delphi/ NET
Level 1

- AAlZF &Ef HH0|E 7| dE/ghet

© sdex el

SYNOPSIS

O VT_I4 cmcGnSetStatusUpdatelnterval ([in] VT_I4 BoardID, [in] VT_I4 dwInterval)
O VT_I4 cmcGnGetStatusUpdatelnterval ([in] VT_I4 BoardID, [out] VT_PI4 dwinterval)

DESCRIPTION

cmcGnSetStatusUpdatelnterval() B S| o| B2 FH A== AL G HHlo|E
F715 AU Eelo| B E R dEE = AA L B (MIO, Feedback Speed, Feedback
Position )7} A€ F7]vprt A G o] E Yt

cmcGnGetStatusUpdatelnterval() 3 S8 o] 2 FH A ¥ = A AL A H GHlo]|E
F71E wrEkey o

Aol E F7]& 5 o= w9l = us(10-6s), 271862 1us YUt

o] 2] A8} TEo o, AlFE @AW Fo}] $5 3T Visual Basic ol A= 9]
A5 eme 7F A 25U

PARAMETER
» BoardID: AF-&-2H7} A7 §F tnlo] 2~ (B =) ID.

P dwinterval: S8 o] L2 HE D= = A GE HdlolE 79Ut drate=
9] ps(10-6s), 7] 7k 1ps Y k.

-

P dwinterval: S| o| B2 HE AE & = AA A Sy ol E 7] & wkskshy)

RETURN VALUE

Value Meaning
55 o A9 AR S ol A A Aagin

ERR_NONE S
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NAME INFORMATION

"7 F